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About This Guide

This guide includes information on Novell® NetStorage, which provides secure Internet-based 
access to files and folders on a NetWare® server in your network using either a browser or 
Microsoft* Web Folders.

The following are included in this guide:

Chapter 1, “NetStorage Overview,” on page 9

Chapter 2, “Installing NetStorage,” on page 13

Chapter 3, “Administering NetStorage,” on page 17

Chapter 4, “Troubleshooting NetStorage,” on page 27

Chapter 5, “Using NetStorage,” on page 31

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for 
other platforms, the pathname is presented with a backslash. Users of platforms that require a 
forward slash, such as UNIX* or Linux, should use forward slashes as required by your software.

User Comments

We want to hear your comments and suggestions about this manual and the other documentation 
included with NetWare 6.5. To contact us, use the User Comments feature at the bottom of any 
page in the online documentation.
About This Guide 7
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1 NetStorage Overview

NetStorage provides secure Internet-based access to files and folders on a NetWare® server in your 
network using either a browser or Microsoft Web Folders (Microsoft’s implementation of 
WebDAV). NetStorage authentication relies on the power of Novell® eDirectoryTM to provide 
secure access, so Internet-based access is as secure as accessing files from within the network.

Novell NetStorage includes the following benefits:

Lets users securely copy, move, rename, delete, read, and write files between any Internet-
enabled machine and a NetWare server on your network.

Lets users access archived copies of their files (see the Novell Archive and Version Services 
2.0 for NetWare Administration Guide for OES).

Eliminates the need to use a virtual private network (VPN) client to access files.

Eliminates the need to e-mail or copy data from one machine to another.

Supports Internet standards such as HTTP, HTTPS, HTML, XML, and WebDAV.

Supports the use of drive mappings that users are accustomed to when they log in using the 
Novell ClientTM (see “What Users See When They Access NetStorage” on page 10).

Supports access to users’ Novell iFolder® accounts.

Provides access to network files and folders via NetWare WebAccess, Novell iFolder, and 
Novell exteNd DirectorTM 4.1 Standard Edition.

Supports Storage Location objects used to display a specified name for a network directory in 
the NetStorage directory access list displayed through Microsoft Web Folders or a Web 
browser (see “Storage Location” on page 23).

With NetStorage installed on one NetWare 6.5 server, users can potentially have access to any 
NetWare 5 or later server anywhere on your geographically dispersed network.

How NetStorage Works
NetStorage is installed on one NetWare 6.5 server that acts as a Middle Tier (also known as XTier) 
server. Middle Tier server configuration information is stored in the NetWare registry and Novell 
iManager provides an easy method for changing Middle Tier server registry entries. Xtier is 
Novell’s Web services framework and is used by various Novell products. 
NOTE: Previous versions of NetStorage were administered using the NSAdmin utility. Configuration should 
now be done through Novell iManager.

After the Middle Tier server is set up, it appears as an Internet Web server to users and can be 
accessed either with a Web browser or with Microsoft’s Web Folders. NetStorage also provides a 
gadget that provides access through Novell exteNd DirectorTM 4.1 Standard Edition.
NetStorage Overview 9
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The Middle Tier server communicates with the Novell file servers in the network and provides 
secure authentication using eDirectory and the users’ usernames and passwords. NetStorage also 
provides secure access to files that users have located on Novell iFolder servers.
NOTE: Users must have their iFolder user accounts enabled through the iFolder server in order to access their 
files stored in iFolder using NetStorage. You must also enable the ability for users to set iFolder passphrases 
in NetStorage. For more information on iFolder, see the Novell iFolder 2.1 online documentation (http://
www.novell.com/documentation/lg/ifolder21/index.html).

iFolder 2.1 does not support 56-bit encryption. If you are using 56-bit encryption, you must use iFolder 1.03.

All transactions can also be encrypted using SSL to increase the security. Novell iFolder 
transactions are secured using the iFolder encryption mechanism. 

For more detailed information on creating and using login scripts, see the Novell Login Scripts 
Guide. For specific information on how login scripts are processed by NetStorage, see "Login 
Script Processing by NetStorage" TID10068983 (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/10068983.htm).

What Users See When They Access NetStorage
The NetStorage Web page displays the network files and folders currently accessible for each user. 
NetStorage reads the user’s login script to determine drive mappings, reads eDirectory User object 
properties to determine the path to the user’s home directory, reads the user’s Novell iFolder 
account, then displays a list of files and folders based on the mapped drives, home directories, and 
iFolder account. If Storage Location objects have been created and the user has rights to view these 
objects, the directories associated with these objects are also displayed. 
10   NetWare 6.5 NetStorage Administration Guide
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NetStorage reads the container, profile, and user login scripts only from the primary eDirectory 
server specified during the installation and displays the user’s drive mappings based only on those 
login scripts. However, because login scripts were designed to be processed by the Novell Client 
on the user's workstation, NetStorage processes only a subset of the login script functions. 
TIP: If you specified alternate IP addresses or DNS names of servers in other eDirectory trees during the 
NetStorage installation, NetStorage reads the User object properties in the other eDirectory trees and also 
displays those home directories. This is useful if a user normally logs in to more than one eDirectory tree and 
you want that user to have access to additional home directories in different eDirectory trees using NetStorage. 
The User object name must be the same for each eDirectory tree.

NetStorage processes login scripts in order to find MAP statements. Each MAP statement defines 
a NetWare file system storage resource that the user will be able to access using NetStorage. IF, 
ELSE, END, INCLUDE, and EXIT commands are also recognized by NetStorage. All other login 
script statements are treated as comments and ignored. Finally, login script variables are also 
recognized. Variables are preceeded by a percent sign (%).

Users might have specific eDirectory rights to certain files and folders on your network but will 
not be able to access those files and folders using NetStorage unless login script drive mappings 
exist to those folders or the files and folders are in the user’s home directory. If you want to provide 
users with NetStorage access to a specific folder, you might have to add a drive mapping command 
to that folder in a login script (container, profile, or user).

What’s Next
For more information on installing NetStorage, see Chapter 2, “Installing NetStorage,” on 
page 13.

After you have installed NetStorage, you can administer settings. See Chapter 3, “Administering 
NetStorage,” on page 17.

If you need to troubleshoot issues with NetStorage, see Chapter 4, “Troubleshooting NetStorage,” 
on page 27.

If you need to provide users with information on how to use NetStorage, see Chapter 5, “Using 
NetStorage,” on page 31.
NetStorage Overview 11
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2 Installing NetStorage

NetStorage can be installed as an optional component during the Manual NetWare® 6.5 installation 
or it can be installed after the installation. For most networks, you need NetStorage installed on 
only one server; however, this might vary depending size and your organization’s needs. For 
example, if your company is geographically dispersed, you might want to install NetStorage on 
one server in each geographic region.

During the NetStorage installation, you are prompted for configuration information that is 
necessary for NetStorage to function properly. If you change the NetStorage configuration later, 
you must either reinstall or use Novell® iManager to change the configuration. For more 
information on iManager, see Chapter 3, “Administering NetStorage,” on page 17.

Requirements
In addition to meeting the requirements for NetWare 6.5, NetStorage requires the following:

Server Requirements: At least one NetWare 6.5 server in the Novell eDirectoryTM tree where 
NetStorage will be installed. 

An eDirectory replica is not required to be on the same server where NetStorage is installed.
IMPORTANT: In order to avoid time issues, this server must have time set correctly according to your 
network specifications. If time is not set, workstations might not be able to access files. 

Workstation Requirements: Netscape* Navigator* 4.7 or later, Internet Explorer 5.5 or 
later, or Microsoft Web Folders.

Installing Novell NetStorage during the NetWare 6.5 Installation
1 Start the NetWare 6.5 installation (either Default or Manual) and continue until you get to the 

page requiring you to choose component options.

The NetWare 6.5 installation includes several steps not described here because they do not 
directly relate to this installation. For more detailed instructions on the installation, see 
"“Installing OES for NetWare”" in the OES for NetWare Installation Guide.

2 When the Choose a Solution page appears, select Manual NetWare, then click Next. 

You can also install other products during this installation.

Continue through the installation until you get to the page that lists the different installation 
types.

3 Select the Customized NetWare Server installation option. 

4 In the Components page, check the Novell NetStorage, Apache 2 Web server, and iManager 
check boxes, along with the other components you want installed with NetWare 6.5, and then 
click Next.

Continue with the installation process.
Installing NetStorage 13
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5 When you reach the NetStorage Install page, specify the IP address or registered DNS name 
of a server in your eDirectory tree that has the master replica or a read/write replica of 
eDirectory.

The primary eDirectory server URL is required for NetStorage to function properly. This does 
not necessarily have to be the IP address or DNS name of the server where NetStorage is to 
be installed.

When a user attempts to log in, NetStorage searches the eDirectory database on the server you 
specify for the User object. If the User object is found, NetStorage attempts to authenticate the 
user to eDirectory. 

If you know the eDirectory context for the users that will use NetStorage, you can add that 
context to the URL by inserting a colon (:) between the IP address or DNS name and the 
eDirectory context. The context is optional. If no context is specified, NetStorage searches the 
entire eDirectory tree on the primary eDirectory server for User objects.

For example, if the IP address of the server is 127.0.0.1 and the eDirectory context for your 
users is personnel, then you would add 127.0.0.1:personnel to the field.

6 (Optional) Specify IP addresses or DNS names of servers in other eDirectory trees that have 
at least read/write eDirectory replicas, or specify the same IP address or DNS name you used 
for the primary eDirectory server but with a different context.

You can add two alternate eDirectory server IP addresses or DNS names and context settings. 
These alternate settings are used to allow NetStorage to find User objects that exist in contexts 
other than what you specified for the primary eDirectory server. The alternate settings also 
allow NetStorage to find User objects with the same name in different eDirectory trees. 
Although the alternate URL and context settings are optional, they can help provide an 
additional level of access to NetStorage.

7 (Optional) Specify the IP address or DNS name and the port number that you assigned to 
Novell iFolder®.

The iFolder DNS name or IP address and the port number are optional but, if specified, will 
allow NetStorage users to access and manipulate files and directories in their iFolder 
directories on the iFolder server. 

Users must have their iFolder user accounts enabled through the iFolder server in order to 
access their files stored in iFolder using NetStorage. You must also enable the ability for users 
to set iFolder passphrases in NetStorage. For more information on iFolder, see the Novell 
iFolder 2.1 online documentation (http://www.novell.com/documentation/lg/ifolder21/
index.html).
TIP: If you are installing NetStorage during the NetWare 6.5 installation, you can click the Back button to 
go back and view the screen where the IP address and port number assignments were made. This does 
not necessarily need to be the IP address or DNS name of the server where NetStorage is to be installed.

8 (Conditional) If you are running in a clustered environment, install NetStorage on two nodes 
in the cluster using the identical configuration used on the first server. 

The default configuration for Apache2 on NetWare 6.5 is to listen on all IP addresses. This is 
done with a Listen directive in sys:\Apache2\conf\httpd.conf that only specifies a port and 
doesn't have a specific IP address. If you have modified the default configuration to listen on 
a specific IP address, and you want the server to be a part of a cluster, you should either 
remove the specific IP address or add another Listen directive that does not specify an IP 
address so that Apache2 listens on all IP addresses.
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For more information about running NetStorage in a clustered environment, see 
"“Configuring NetStorage with Novell Cluster Services”" in the Novell Cluster Services 
Resource Configuration Guide.

After you install NetStorage, it will start automatically when you start your NetWare 6.5 server. If 
NetStorage is not accessible, restart the NetWare 6.5 server where NetStorage is installed.

Installing Novell NetStorage after the NetWare 6.5 Installation
If you did not install NetStorage during the NetWare 6.5 installation, you can install it later by 
completing the following steps:

1 Insert the NetWare 6.5 Products CD into your NetWare 6.5 server.

You might need to load cddvd.nss on the server to access this CD.

2 From the Novell menu on the NetWare 6.5 console GUI, select Install.

3 Click Add, then browse to the root of the NetWare 6.5 Products CD.

4 Select the product.ni file, then click OK.

5 Check the NetStorage, Apache, and iManager check boxes and deselect all other components 
or products unless you specifically want to install them.

6 Go to Step 5 on page 14 to complete the NetStorage installation.

7 Restart the NetWare 6.5 server.

After you install NetStorage, it will start automatically when you start your NetWare 6.5 server. If 
NetStorage does not start automatically, restart the NetWare 6.5 server where NetStorage is 
installed.

What’s Next
After you have installed NetStorage, inform users that they can access their files from the Web. 
Instructions for accessing files using NetStorage are available in Chapter 5, “Using NetStorage,” 
on page 31.

Users might have specific eDirectory rights to certain files and folders on your network but will 
not be able to access those files and folders using NetStorage unless storage location objects have 
been created, login script drive mappings exist to those folders, or the files and folders are in the 
user’s home directory. If you want to provide users with NetStorage access to a specific folder, you 
might have to add a drive mapping command to that folder in a login script (container, profile, or 
user).

If you need to change the NetStorage configuration, use iManager. See Chapter 3, “Administering 
NetStorage,” on page 17.
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3 Administering NetStorage

You can change your NetStorage configuration after NetStorage has been installed on a NetWare® 
server (known as the Middle Tier or XTier server) using Novell® iManager. NetStorage 
configuration information is stored in the NetWare registry and iManager provides an easy method 
for changing NetStorage registry entries. iManager requires Internet Explorer 5 or later.

If you are running in a clustered environment, any registry changes made to one node in the cluster 
must be made to the registry of each node in the cluster. After you have made a change to one node, 
run iManager on each node in the cluster and make the same changes. For more information about 
running NetStorage in a clustered environment, see the "“Configuring NetStorage with Novell 
Cluster Services”" in the Novell Cluster Services Resource Configuration Guide.
IMPORTANT: After changing any settings you must reboot your NetWare server or restart the Apache Web 
server. To restart the Apache Web server: At the server console, enter Ap2WebDn to stop the Web server and 
then enter Ap2WebUp to restart the Web server. 

Using iManager to Administer NetStorage
1 Start your internet browser and enter the URL for iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the NetWare 6.5 server running NetStorage or the IP address for 
Apache-based services.

The date and time on the workstation being used to access NetStorage should be reasonably 
close (within a few hours) to the date and time on the server running NetStorage to avoid 
conflicts.

2 Enter your username and password.

3 In the left column, locate the File Access (NetStorage) configuration options you want to 
change.

iManager displays a list of links in the left column that are used to access the various pages 
for editing and viewing NetStorage configuration information in the NetWare registry. For 
more information on each setting, click Help or see “Understanding the NetStorage 
Configuration Settings” on page 18.

4 Make the necessary configuration changes.

5 (Conditional) If you are running in a clustered environment, run iManager on each node in the 
cluster and make the same changes. 

For more information about running NetStorage in a clustered environment, see the 
"“Configuring NetStorage with Novell Cluster Services”" in the Novell Cluster Services 
Resource Configuration Guide.
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Understanding the NetStorage Configuration Settings
This section includes information on all configuration settings that can be set. The settings are 
organized according to the link in the left column that they appear under. This information is also 
available if you click Help.

“Authentication Domains” on page 18

“Current Sessions” on page 19

“Files” on page 19

“iFolder Storage Provider” on page 19

“NetWare Storage Provider” on page 20

“NetStorage Options” on page 21

“NetStorage Statistics” on page 22

“Resource Usage” on page 22

“WebDAV Provider” on page 23

“Storage Location” on page 23

Authentication Domains
Lets you change or add the Novell eDirectoryTM server URLs and contexts that are required by 
NetStorage. This page also lets you change the eDirectory server that is designated as the Primary. 
See “Installing Novell NetStorage during the NetWare 6.5 Installation” on page 13 for more 
information about eDirectory server URLs and contexts.

Settings Description

Add Domain Adds another eDirectory server IP addresses or DNS name. Users are 
authenticated to this eDirectory server.

Make Primary Makes the eDirectory server URL listed above the button the Primary.

Remove Domain Removes the eDirectory server URL from the list of URLs used by NetStorage.

Add Context Adds a context that NetStorage searches when authenticating users. Use periods 
to separate the context. For example, ou=users.o=digitalair. If the user is not 
located in the first context, any additional contexts added here is searched. If the 
user is not found in any context listed, an LDAP search of all subdirectories is 
performed. If clear-text passwords are not enabled on the server, this search fails.

Remove Context Removes the context (if there is one) from the eDirectory server URL.
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Current Sessions
Displays a report with information on the current NetStorage sessions.

Files
Displays the NetStorage Web page. This provides a way to access NetStorage from iManager, 
without entering the NetStorage URL. See Chapter 5, “Using NetStorage,” on page 31 for more 
information on the NetStorage Web page.

iFolder Storage Provider
If you have Novell iFolder® installed on your NetWare server, you can view or edit the following 
iFolder-specific configuration settings.

Add Host Lets you list additional hosts for an Authentication Domain. Clicking the Add Hosts 
button lets you create a list of alternative hosts for the domain.

If the Middle Tier server cannot reach the host specified in the domain, it searches 
the Other Hosts list specified in the Value field to find another server to use for 
authentication. Specify DNS names or IP addresses of alternate servers, 
separated by a comma delimiter, in the Value field.

For example, you could enter a string similar to the following:

Middletier.boston.digitalair.com,Middletier1.boston.digitia
lair.com

or

111.22.33.4,111.22.33.41

Settings Description

Root The name of the root directory for iFolder. The root iFolder directory is a virtual 
directory, and changing it will change the iFolder directory name users see when 
accessing their files and directories on the iFolder server. The default is iFolder.

Passphrase Form 
Protocol

Default is HTTPS. This field should not be changed unless you want users’ 
passphrases to be sent in clear text.

iFolder Server The DNS name and port number for the iFolder server. This setting shouldn’t need 
to be changed unless you are changing the iFolder server your users will access.

If you click the Set Defaults button, the value is set to whatever value appears in 
the Default Value column. If there is no value in the Default Value column, the value 
is set to blank (no value).

Secure Port The port number that HTTPS is running on. This setting normally does not need to 
be changed. The default is 443.

Settings Description
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NetWare Storage Provider

Settings Description

Home Name This text is displayed on the NetStorage Web page and is followed by the tree 
name and path to the user’s home directory. The user might have home directories 
in multiple trees, in which case multiple paths are displayed. 

The default is Home@. You might want to change this if you want to reference 
home directories with a different word or in a language other than English. See the 
"Alternate Tree Name" listing below for more information on configuring 
NetStorage to display multiple home directories.

Drive Name This text is displayed on the NetStorage Web page and includes the drive letter 
being referenced followed by the path to the mapped drive. The user’s login script 
on the Primary tree is parsed by NetStorage to gather information on mapped 
drives. You might want to change this if you want to use a different word or words 
to reference mapped drives on the NetStorage Web page.

Public Directory 
Name

This registry key provides a way for any NetStorage user to make documents or 
files available to other NetStorage users.

A public directory can be automatically created in each user’s home directory by 
NetStorage. If public directories are created by NetStorage, all users in the same 
eDirectory context will have Read and File Scan rights to the other users’ public 
directories.

If you don’t want public directories created in users’ home directories, leave this 
field blank (the default).

If you want public directories created in users’ home directories, enter the name for 
the public directories. For example, if you specify My Public Files as the name for 
the public directories, a folder named My Public Files is created at the root of each 
user’s home directory the first time the user logs in using NetStorage.

To access a public directory, users need to add ~username at the end of the URL 
used to access NetStorage. For example if you want to access the public directory 
for a user named jsmith, you might specify a URL similar to http://file.i-login.net/
oneNet/NetStorage/~jsmith.

Alternate Tree 
Name

When a user’s home directory is displayed by NetStorage, the name of the 
eDirectory tree is also displayed. With this configuration field, you can substitute 
the tree name that users see in NetStorage to something that might be more 
intuitive. For example, if the tree name is SERVICES 2 and you want users to see 
i-Login, you would type SERVICES2/i-Login in this configuration field. The 
eDirectory tree name and the substitute name are separated with a slash (/).

NetStorage can access user home directories in multiple eDirectory trees. If you 
want to substitute eDirectory tree names in more than one tree, separate those 
tree name substitutions with a comma. An example of this is SERVICES2/i-
Login,SERVEME2/Staging.

Container Search 
Height

Specifies the number of container levels (from where the User object is located) 
that NetStorage will search up in the eDirectory tree for the container login script. 
The default is 1, which is the same level used by Novell ClientTM software.

If you specify a number greater than the number of container levels in the 
eDirectory tree, NetStorage will search up to and including the root container in the 
tree. If you specify 0, NetStorage will only search the container where the User 
object is located.
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NetStorage Options

Home Dirs Specifies if home directories are to be processed. The default is 1, meaning that 
they are processed. If you specify 0, no home directories are processed or 
displayed to the user.

Check MAP Drives Specifies if mapped drives (from login script MAP statements) are checked when 
the user logs in. The default is 0, meaning that mapped drives are not checked and 
all mapped drives are displayed to the user. If the user attempts to access a 
mapped drive pointing to a directory that does not exist or that the user does not 
have access rights to, an error occurs. 

If you specify 1, each mapped drive is checked at login and map drives that do not 
exist or that the user does not have access to are not displayed. 

Settings Description

Proxy Username 
and Proxy 
Password

The admin username and password that you entered when you installed your 
NetWare server. If you want the Middle Tier Server to use a different username and 
password for administrator access, specify them in the fields provided.

If you click the Set Defaults button, the value is set to whatever value appears in 
the Default Value column. If there is no value in the Default Value column, the value 
is set to blank (no value).

Location The registered location you want users to enter as part of the NetStorage URL to 
access NetStorage. The default is oneNet.

If you change this registry setting, you must also edit the netstorage\xsrv.conf file 
and change the /oneNet setting in the Location section (first section) to the same 
setting you specified in iManager. 

Certificate Name The default certificate name is SSL CertificateDNS. If you purchased a certificate 
that you want to use, or if you just want to use a different certificate, type the 
certificate name in this field.

Any certificates used by NetStorage should reside in the same eDirectory context.

Session Timeout The amount of time (in seconds) that the session will remain idle before it is 
terminated. If there is no NetStorage activity for this amount of time, the user is 
required to log in again to NetStorage before being allowed file access.

Janitorial Level This setting should not be changed except under direction from Novell.

Settings Description
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NetStorage Statistics
Displays a report with information about server up time, login failures, number of NetStorage 
sessions, etc.

Resource Usage
Displays a detailed report of resource utilization for NetStorage. 

Persistent 
Cookies

This setting can be turned either on or off. With the value set to 0, Persistent 
Cookies is turned off. Persistent Cookies is turned off (the default) if there is no 
value or if the value is set to 0.

With Persistent Cookies turned off, the NetStorage session will end when the user 
closes the current browser or Web folder. Also, if the user has a current instance 
of NetStorage running in a browser window or Web folder and starts up a new 
browser instance or Web folder, the user will be required to reauthenticate. 

Turning off Persistent Cookies can be beneficial if you have workstations that are 
shared because as long as the browser instance is closed down, the next user of 
the workstation cannot accidentally or intentionally obtain access to your network 
through NetStorage. 

Leaving Persistent Cookies turned on can be beneficial if your workstations are not 
shared because it prevents users from having to unnecessarily re-authenticate. 

If the user selects the Logout option in NetStorage, the session will end regardless 
of whether Persistent Cookies is turned on or off. 

LDAP Port Lets you change the LDAP port number if there is a conflict between Active 
Directory* and eDirectory for LDAP requests.

This conflict exists because the back end is acting as a domain controller that has 
Active Directory installed on it. The conflict is created by both eDirectory and Active 
Directory attempting to use the same default port (number 389). Active Directory 
normally wins the conflict. The Proxy User object type exists in eDirectory but not 
in Active Directory. Because of this, when the Middle Tier server tries to bind as a 
Proxy User, the bind attempt fails. This is also the reason LDAP lookups fail.

Cookieless The Cookieless option can be turned either on or off. With the value set to 0, 
Cookieless authentication is turned off (the default). Cookieless authentication can 
be turned on by setting the value to 1.

Cookieless authentication is needed for some clients that use versions of WebDav 
that don't support cookies. For example, Apple clients use a WebDav version that 
does not support cookies.

If Cookieless Authentication is turned on, you must close all browser instances to 
logout.

Settings Description
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WebDAV Provider

Storage Location 
You can create a Storage Location object to display a specified name for a network directory in the 
NetStorage directory access list displayed through Microsoft Web Folders or a Web browser. 
Creating a Storage Location object is useful if users expect that the directory will have a certain 
name. Unlike directories that are displayed from a login script, Home directory, or iFolder that 
have a name that cannot be altered, you can specify the Storage Location object name. 

After you have created a Storage Location object, you must associate this object with a User, 
Group, Location, or Container object. Users will see the directory associated with the object the 
next time they log in.

Creating a Storage Location Object

1 Start Start your browser (Internet Explorer 5 or later, Mozilla, etc.) and specify the URL for 
iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the NetWare 6.5 server running NetStorage or the IP address for 
Apache-based services.

2 Type your username and password.

3 In the left column, click File Access, then click New Storage Location.

4 Specify the object name, display name, display location, context, and a comment.

The object name is the name of the object in the eDirectory tree.

The display name is the name to be displayed in the NetStorage directory access list. This is 
the shortcut name and is seen by users. If you use the same display name for two different 
Storage objects, a digit is added to the names to make each name unique. 

The directory location is the location of the directory on the file system. The location is a URL 
that includes the file system type, server name, volume, and directory path and it must be in 
the following format:

ncp://server_name/volume/path_to_directory

For example: 

ncp://server1.digitalair.com/mktg/reports

or

ncp://111.222.3.4/mktg/reports

If the file system is omitted, it is assumed that it is NCPTM.

Settings Description

Monkier The location of the NetStorage WebDAV provider (xdav.nlm). It is the location you 
want users to specify as part of the NetStorage URL to access NetStorage. The 
default is NetStorage.

Template 
Directory

The directory for the HTML interface. This setting should not be changed except 
under direction from Novell.
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The context is the directory context that the Storage Location object resides in. Click the 
object selector to select the context. 

The comment is entered by the administrator and is not displayed to users.

5 Click Create, then click OK.

Creating or Modifying a Storage Location List

After you create a Storage Location object, you must create a list of Storage Location objects that 
can be used with a specified User, Group, Profile, or Container object. Users will see the directory 
associated with the object the next time they log in. After this list is created, you can modify it from 
the same window by assigning additional Storage Location objects to the list or by deleting Storage 
Location objects from the list. 

1 Start your browser (Internet Explorer 5 or later, Mozilla, etc.) and specify the URL for 
iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the NetWare 6.5 server running NetStorage or the IP address for 
Apache-based services.

2 Type your username and password.

3 In the left column, click File Access, then click Assign Storage Location to Object.

4 Click the Object Selector button; select the User, Group, Profile, or Container object that the 
list is to be created for; then click OK.

5 Click the Object Selector button, select the Storage Location objects you want included in this 
list, then click OK. 

You can select multiple Storage Location objects in the Object Selector window. When you 
select multiple Storage Location objects, they appear in the Selected Objects list. If the list 
already contains Storage Location objects and you want to add more, ensure that the original 
objects are still in the list before clicking OK.

You can remove existing storage locations by deleting their names from the list before 
clicking OK.

6 When you are finished creating or modifying the list, click OK.

Modifying a Storage Location Object

1 Start your browser (Internet Explorer 5 or later, Mozilla, etc.) and specify the URL for 
iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the NetWare 6.5 server running NetStorage or the IP address for 
Apache-based services.

2 Type your username and password.

3 In the left column, click File Access, then click Edit Storage Location.

4 Click the Object Selector, then select the Storage Location object that you want to modify.

5 Modify the display name, display location, or comment, then click OK.

If you need to modify the object name or eDirectory context, you must delete this object and 
create a new Storage Location object.

6 Click OK.
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Deleting a Storage Location Object

1 Start your browser (Internet Explorer 5 or later, Mozilla, etc.) and specify the URL for 
iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the NetWare 6.5 server running NetStorage or the IP address for 
Apache-based services.

2 Type your username and password.

3 In the left column, click File Access, then click Delete Storage Location.

4 Click the Object Selector button, then select the Storage Location object that you want to 
delete.

5 Click OK.

What’s Next
After you have configured NetStorage, inform users that they can access their files from the Web. 
Instructions for accessing files using NetStorage are available in Chapter 5, “Using NetStorage,” 
on page 31.
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4 Troubleshooting NetStorage

This section contains information on common troubleshooting issues. In addition to this 
information, additional information is located in Technical Information Documents (TIDs) 
available in the Knowledgebase on the Novell® Support Web site (http://support.novell.com). 

Unexpected Results from Login Scripts
When a user authenticates to NetStorage, the login scripts associated with the Novell eDirectoryTM 
User object in the primary authentication domain are processed. These login scripts are the same 
scripts processed by the Novell ClientTM. 

However, because login scripts were designed to be processed by the Novell Client on the user's 
workstation, some of the defined statement types and script variables cannot be processed by 
NetStorage. 

Specific information about how login scripts interacts with NetStorage is available in theNovell 
Login Scripts Guide.

Logging In As a Different User
If you are using Windows* 98 and Internet Explorer and, after logging in to NetStorage you intend 
to log in again as a different user, you must first delete Internet Explorer cookies and log out from 
Windows 98 or you will not be able to log in again. This is necessary because Windows 98 retains 
user information and NetStorage cookies are created that are user-specific. 

When using Windows 2000 and Microsoft* Web Folders, you must enable the Launch Folder 
Windows in a Separate Process option:

1 Double-click My Computer, then click Tools > Folder Options > View. 

2 Check the Launch Folder Windows in a Separate Process check box.

For all versions of Windows and Internet Explorer, configure Internet Explorer to prompt for 
username and password:

1 Click Tools > Internet Options > Security > Custom Level. 

2 In the User Authentication Setting section, click Prompt for Username and Password > OK > 
OK.

Slow Login
The most common cause of a slow login to NetStorage is large or poorly configured login scripts.   
When a user authenticates to the Primary Authentication domain, all applicable login scripts for 
that user object are processed. The more commands executed, the longer the login process.
Troubleshooting NetStorage 27

http://support.novell.com
http://support.novell.com


    Novell Confidential                                                                                            Manual (ENU)  21 December 2004
Invalid authentication domains can also slow the login process. After the user has been 
authenticated to the Primary authentication domain, the same username and password is used to 
authenticate to any Secondary authentication domains. Authentication failure on any of these 
domains will slow logins. Users can successfully authenticate to the Primary Authentication 
domain but fail at each of the secondary domains.

It is helpful to determine if slow logins are global (all users) or specific to a given user object. If 
all users are affected, it is more likely to be a problem with the Xtier authentication domain 
configuration. If a single user or groups of users are affected, check all login scripts that apply to 
that user or group. A problem with a context's login script can affect a large number of users. 
Mapping out which scripts apply to which users can help narrow the problem.

For more information on how NetStorage works with Login Scripts, see “Understanding How 
Login Scripts Work with NetStorage” in the Novell Login Scripts Guide.

Configuring LDAP Contextless Login for use with NetStorage
When configuring LDAP contextless login, consider the following issues. 

Primary Authentication Domain: The user must be authenticated to the Primary Authentication 
domain (an eDirectory server with a replica). You can provide more than one context in the 
Primary Authentication domain resulting in each context being searched for the presence of the 
user. The search is performed using an LDAP search of the configured contexts.

Secondary Authentication Domain: After the user has been authenticated to the Primary 
authentication domain, the same username and password are used to authenticate to any Secondary 
authentication domains. The search is performed using an LDAP search of the configured contexts 
for that domain. If authentication to any Secondary domains is unsuccessful, the user is still 
authenticated to the Primary authentication domain. Authentication failure on a Secondary domain 
can cause a delay in the login process and is one of the most common causes of slow logins to 
NetStorage.

Enable TSL for Simple Binds with Passwords: Passwords are encrypted in NetWare 6.5, so you 
must enable TLS for simple binds with passwords in LDAP. For more information, see “Requiring 
TLS for Simple Binds with Passwords” in the Novell eDirectory 8.7.3 Administration Guide.

LDAP will need read and browse rights to the entire tree. By default, when a user performs an 
anonymous bind (doesn't specify a password), a special object in the directory calculates access 
control for that user. This object is termed [Public]. By default, this object can browse the entire 
tree hierarchy and read a limited number of attributes on entries. For more information on 
anonymous binds, see “Understanding How LDAP Works with eDirectory” in the Novell 
eDirectory 8.7.3 Administration Guide.

If you'd like to have an anonymous bind use a different object in the tree, you can specify that 
object in the Proxy Username field. By doing this, you can restrict the types of objects and 
attributes that anonymous users can access by setting the appropriate access controls on the proxy 
user object. The proxy username must be a distinguished name. To easily select an object, click 
the directory browser button to the right of the text field on the LDAP Group Object. A dialog box 
appears that allows you to choose an object in the tree. Any eDirectory user object can be used and 
anonymous access will assume the rights of that user.
IMPORTANT: A proxy user must have a blank password in order to work correctly. This is very different from 
having no password. If any user has no password, then they do not have a public/private key pair to compare 
against when attempting login. A blank password will generate a public/private key pair, although the actual 
string for the password is empty.
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Novell iFolder and NetStorage
When troubleshooting a NetStorage and Novell iFolder® issue, it is important to first determine if 
it is a NetStorage problem or an iFolder problem. It is easy to spend a great deal of time working 
the problem from the NetStorage end only to find that the user cannot access iFolder directly. A 
few simple tips can help speed the identification of the problem.

1. Take NetStorage out of the equation. Make sure the User can successfully log into iFolder 
with the iFolder client or applet. If login is unsuccessful, the problem is with iFolder and 
should be addressed there. If the user successfully logs in to iFolder, begin troubleshooting 
the NetStorage application.

2. Enable debugging for the iFolder Storage Provider. In iManager, click iFolder Storage 
Provider and change the Debug Level from 0 (default) to FFFFFFFF, then restart the server. 
Log in to NetStorage and attempt to access iFolder. The server logger screen will now display 
all warnings and errors related to the iFolder Provider.

3. Create a new user for testing. Some problems are user-specific and some problems affect all 
users. Creating a test user can help to determine this. When creating a test user for 
troubleshooting, login scripts and home directories are not needed.

Character Set Issues with Netscape
If you use the Netscape browser to open NetStorage, square boxes will be displayed in place of 
some characters. To resolve this, click View > Character Set > Unicode (UTF-8) and then click 
View > Character Set > Set Default Character Set.

Configuring NetStorage With iChain
If you are configuring NetStorage to run behind an iChain server (fronting NetStorage with 
iChain), there are some configuration changes required in order for NetStorage to function 
properly. These configuration changes include enabling cookieless authentication and editing the 
logout.html.utf8 file.

Enabling Cookieless Authentication
1 Open your browser (Internet Explorer 5 or later, Mozilla, etc.) and specify the URL for 

iManager.

The URL is http://server_ip_address/nps/imanager.html. Replace server_ip_address with the 
IP address or DNS name of the Linux server running NetStorage or the IP address for Apache-
based services.

2 Type your username and password.

3 In the left column, click File Access, then click NetStorage Options.

4 Set the value for the Cookieless option to 1.

The Cookieless option can be turned either on or off. With the value set to 0, Cookieless 
authentication is turned off (the default). Cookieless authentication can be turned on by setting 
the value to 1.

If Cookieless Authentication is turned on, you must close all browser instances to log out.
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Editing the logout.html.utf8 file
The logout.html.utf8 file is located in the sys:/tomcat/4/webapps/netstorage directory on the Linux 
server where NetStorage is installed. Edit the file and replace <iChainDNS> with the DNS name 
of the iChain server. To enable iChain logout, some lines must be uncommented and others must 
be removed. There are instructions in the file on which lines to remove and uncomment.

Phantom Folders
There may be a phantom folder that appears with some uses of Microsoft WEBdav. The phantom 
folder has a different icon than normal folders, and should be ignored.

A phantom folder usually appears when using My Network Places on a Windows client. My 
Network Places uses Microsoft's WebDAV client, which gets confused and thinks that the 
directory name returned means that there is also a subdirectory with the same name.
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5 Using NetStorage 

NetStorage provides secure Internet-based access to files and folders on a NetWare® server in your 
network using either a browser or Microsoft* Web Folders (Microsoft’s implementation of 
WebDAV). NetStorage authentication relies on the power of Novell® eDirectoryTM to provide 
secure access, so Internet-based access is as secure as accessing files from within the network.

Based on how NetStorage has been configured, the NetStorage Web page displays the network 
files and folders you have access to. NetStorage reads your NetWare login script to determine drive 
mappings, reads eDirectory User object properties to determine your home directory, then displays 
a list of files and folders based on mapped drives and home directories. If you usually log in to 
more than one eDirectory tree, you might have access to additional home directories in different 
eDirectory trees. If you have a Novell iFolder® account, this account is also displayed. However, 
some NetStorage features such as Download for Editing are not available with Novell iFolder. 

NetStorage reads the container, profile and user login scripts only from the primary eDirectory 
server specified during the installation and displays the user’s drive mappings only based on those 
login scripts.

Users might have specific eDirectory rights to certain files and folders on your network but will 
not be able to access those files and folders using NetStorage unless login script drive mappings 
exist to those folders or the files and folders are in the user’s home directory. If you want to provide 
users with NetStorage access to a specific folder, you might have to add a drive mapping command 
to that folder in a login script (container, profile, or user).

Accessing NetStorage
To access NetStorage from a workstation: 

1 Open your browser or Microsoft Web Folders and specify the URL for NetStorage.

The URL is http://server_ip_address/oneNet/NetStorage/. Replace server_ip_address with 
the IP address or DNS name of the server running NetStorage or the IP address for Apache-
based services. If Apache-based services use a port other than 80, you must also specify that 
port number with the URL.

For example, if the IP address for NetStorage is 127.1.1.1 and the port number is 51080, then 
you would specify 127.1.1.1:51080/oneNet/NetStorage/.

The date and time on the workstation being used to access NetStorage should be reasonably 
close (within a few hours) to the date and time on the server running NetStorage to avoid 
conflicts.

2 Enter your username and password.

NetStorage uses your Novell eDirectory username and password, so you don’t need to 
remember or use a separate username or password.
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You can use many of the same conventions for expanding and contracting folders and opening files 
that are available in Windows Explorer. To create new folders or copy, delete, rename, move, or 
download existing files using a browser, click the File menu. If you are using Internet Explorer, 
you can copy and move files and folders by dragging and dropping them. This functionality is not 
available with browsers other than Internet Explorer.

Clicking the Folder View button in the browser window displays folders in another column and 
lets you expand and contract folders. The Text View displays only the files and folders in the 
current directory and does not let you expand or contract folders.

Local files and folders are not accessible using NetStorage. Also, you cannot map drives or change 
login scripts from NetStorage.

Viewing or Modifying Directory and File Attributes and Rights
NetStorage provides the ability to view or change NSS directory and file rights. This is particularly 
useful if you need to change directory and file rights, but do not have Novell ClientTM software 
installed or running on a client workstation. To view or modify directory or file rights using 
NetStorage

1 Start your browser and specify the URL for NetStorage.

The URL is http://server_ip_address/oneNet/NetStorage/. Replace server_ip_address with 
the IP address or DNS name of the server running NetStorage or the IP address for Apache-
based services. If Apache-based services use a port other than 80, you must also specify that 
port number with the URL.

For example, if the IP address for NetStorage is 127.1.1.1 and the port number is 51080, then 
you would specify 127.1.1.1:51080/oneNet/NetStorage/.

The date and time on the workstation being used to access NetStorage should be reasonably 
close (within a few hours) to the date and time on the server running NetStorage to avoid 
conflicts.

2 Enter your username and password.

NetStorage uses your Novell eDirectory username and password, so you don’t need to 
remember or use a separate username or password.
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3 Right-click the directory or file you want to view or modify attributes or rights for and select 
Properties.

4 Click the NetWare Info tab to view or modify attributes or the NetWare Rights tab to view or 
modify rights.

For more information on directory and file attributes and rights, see the Novell Client for Windows 
Installation and Administration Guide.
NOTE: Viewing or changing directory and file attributes and rights using NetStorage is only possible using a 
browser. This functionality is not available using Microsoft Web Folders. 

Accessing Archived Files
Novell Archive and Version Services provides a convenient and cost-effective way for you to 
instantly restore previous versions of your modified, deleted, or lost files. If your administrator 
configured your network files for versioning, historical copies of your files might exist in an 
archive database. 

For information about Novell Archive and Version Services, see the Novell Archive and Version 
Services 2.0 for NetWare User Guide for OES. 

What Files Get Versioned
Your administrator sets criteria to determine which files are eligible for versioning. Files can be 
included or excluded according to the path, file extension, or filename patterns. If your files meet 
the inclusion criteria, they are eligible for versioning.

Versioning occurs at scheduled intervals, called epochs. It does not matter how much or how often 
you change a file during the epoch; whatever state an eligible file is in when the epoch ends is the 
version that is saved in the archives. This means that a file's lifetime must span the end of an epoch 
to be versioned. 

Versioned files might have a limited life in the archive, depending on the delete policies your 
administrator sets. The administrator sets the maximum keep time and the maximum number of 
versions to retain. The delete policy for some volumes can allow indefinite retention of versioned 
files.

For information about the versioning policies for your files, contact your Archive and Version 
Services administrator.

Accessing File Versions
You can access previous versions of your files whenever you need to by using the NetStorage 
interface. 

To access the Archive function:

1 Log in to NetStorage. 

2 Select a file or directory that you want to see previous versions of.

3 Right-click to open the pop-up menu.

4 Click Archive. 
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To restore a previous version of the file:

1 Navigate through the Archive dialog boxes to find the file you want to see previous versions 
of.

For information about navigating through the Archive dialog boxes, see the Novell Archive 
and Version Services 2.0 for NetWare User Guide for OES. 

2  Review the time stamps of the file versions, then select the version of the file that you want 
to restore.

3 In the Restore To field, type the path and filename where you want to restore the version, or 
browse to that location, type a filename, then click OK.

4 Click Restore.
WARNING: The restored version overwrites any file by that name in the Restore To location.

Setting Directory Quotas on NSS Volumes and Directories
Using NetStorage, you can create or change directory quotas on NSS volumes and directories for 
both NetWare and Linux. See “Conserving Disk Space with Space Quotas” in the Novell Storage 
Services File System Administration Guide for OES. You must be a user with rights equivalent to 
the Admin user to create or change directory quotas.

To create or change NSS directory quotas using NetStorage:

1 Start your browser and specify the URL for NetStorage.

The URL is http://server_ip_address/oneNet/NetStorage/. Replace server_ip_address with 
the IP address or DNS name of the server running NetStorage or the IP address for Apache-
based services. If Apache-based services use a port other than 80, you must also specify that 
port number with the URL.

For example, if the IP address for NetStorage is 127.1.1.1 and the port number is 51080, then 
you would specify 127.1.1.1:51080/oneNet/NetStorage/.

The date and time on the workstation being used to access NetStorage should be reasonably 
close (within a few hours) to the date and time on the server running NetStorage to avoid 
conflicts.

2 Enter your username and password.

NetStorage uses your Novell eDirectory username and password, so you don’t need to 
remember or use a separate username or password.

3 Right-click the directory or file you want to create or change a directory quota for and select 
Properties.

4 Click the NetWare Info tab and then click the Restrict size checkbox.

5 Specify the directory size limt and click Apply to save your changes.

Purging and Salvaging Deleted NSS Files
Using NetStorage, you can purge and possibly undelete NSS files that were previously deleted. To 
do this

1 Access NetStorage, and in the left column, select the directory where the deleted files were.

2 Click View and then Show Deleted Files.
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3 Check the boxes next to the files you want to undelete or purge.

4 Click File and then either Purge or Undelete.
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